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True/False 

Indicate whether the statement is true or false. 

 

 
Figure 4-1 

 

____ 1. In the accompanying figure, the worksheet contains 4 sections.  

 

____ 2. In the accompanying figure, the amortization schedule shows a principal decrease over the life of the loan.  

 

____ 3. Two of the more powerful aspects of Excel are its wide array of functions and its capability 

of organizing answers to what-if questions. 

 

____ 4. You can have more than one instance of Excel running. Besides opening multiple workbooks in Excel, you 

can run multiple instances of Excel. Each instance of Excel will show as a button on the Windows Vista 

taskbar. 

 

____ 5. When you format a cell to display percentages, Excel will not assume that whatever you enter into that cell in 

the future will be a percentage.  

 

____ 6. The Name Manager can help add clarity to your formulas by allowing you to assign names to cells.  

 

____ 7. Worksheets often have column titles at the top of each column and row titles to the left of each row that 

describe the data within the worksheet. 

 

____ 8. Excel instantaneously recalculates all formulas in the worksheet each time you enter a value.  

 

____ 9. The charting feature of PowerPoint assists users in developing a presentation using an outline format and/or 

importing outlines from word processing programs. 



 

____ 10. A command is a set of graphical choices arranged in a grid or in a list.  

 

____ 11. A dialog box can remain open and visible while working on a presentation, but a task pane must be closed 

before continuing to work.  

 

____ 12. The Mini toolbar contains buttons for bold, italics, and alignment.  

 

____ 13. A shortcut menu appears when you right-click an object. 

 

____ 14. The SHIFT key can be used instead of the mouse to display a Key Tip badge.  

 

____ 15. When a line of text is too long to fit in a placeholder, the text is automatically line wrapped.  

 

____ 16. A paragraph is a portion of text with the same format and at the same level when you press the ENTER key in 

a placeholder. 

 

____ 17. The Increase Font Size button is available on the Mini toolbar. 

 

____ 18. Slides cannot be duplicated. 

 

____ 19. PowerPoint 2007 files can be viewed in previous versions of PowerPoint only after downloading a 

compatibility pack from Microsoft. 

 

____ 20. You cannot change text formatting through the Reveal Formatting task pane; you only can view the 

formatting. 

 

____ 21. When a section break is created, you specify whether or not the new section should begin on a new page.  

 

____ 22. Fonts that are not defined in a font set cannot be used. 

 

____ 23. Tables can be centered horizontally between the page margins.  

 

____ 24. To advance from the rightmost column in a table to the next row in the table, press the ENTER key.  

 

____ 25. To resize a chart, you can drag the chart’s sizing handles. 

 
Multiple Choice 

Identify the choice that best completes the statement or answers the question. 

 

____ 26. When you first install Excel, Excel shows ____ in the taskbar. 

a. all open workbooks c. a maximum of 5 open workbooks 

b. 1 of the open workbooks d. 2 open workbooks 
 

 

____ 27. What does Excel do as you enter a function in a cell? 

a. displays the function’s form in a 

ScreenTip 

c. displays the function’s form in the 

ToolTips 

b. calculates the value d. finishes entering the formula 
 
 

____ 28. With a ____, you vary the value in one cell and then Excel calculates the results of one or more formulas and 

fills the data table with the results. 

a. two-input data table c. one–input data table 

b. function d. formula 
 
 

____ 29. How many active data tables are allowed in a worksheet? 

a. 255 c. unlimited 

b. 5 d. 2 
 

 

____ 30. A column border is an unused column with a significantly reduced ____. 

a. cell value c. line dimension 

b. font d. width 
 



 

____ 31. Instead of setting a print range each time, you can also assign a ____ to a range. 

a. function c. name 

b. formula d. number 
 

 

 
Figure 4-4 

 

____ 32. In the accompanying figure, the statement “Cells containing years represented as 2 digits” is an example of 

____. 

a. formulas containing years c. an error checking rule 

b. working with formulas d. enable background checking 
 
 

____ 33. In the accompanying figure, if you select a color in Error Checking, Excel will ____. 

a. keep a color chart of errors found c. look for errors of that color 

b. disallow color in the background d. use the color to represent errors found 
 

 

____ 34. PowerPoint gives a user the flexibility to make presentations _____. 

a. using a projection device attached to a personal computer 

b. by running a virtual presentation on the Internet 

c. using overhead transparencies 

d. all of the above 
 

 



 
Figure 1-2 

 

____ 35. In the accompanying figure, what is the bar between the Slides tab and the Slide pane known as? 

a. separator bar c. status bar 

b. splitter bar d. slice bar 
 
 

____ 36. The _____ is considered the control center in PowerPoint 2007. 

a. menu bar c. Mini toolbar 

b. Quick Access Toolbar d. Ribbon 
 

 

____ 37. Information that you would like to share with your audience but not appear on the slide can be written in the 

____ pane. 

a. Outline c. View 

b. Notes d. Slides 
 
 

____ 38. Dialog boxes can be displayed by clicking the _____ located in the lower-right corner of some groups. 

a. Dialog Arrow c. Dialog task pane 

b. Dialog Box Launcher d. Dialog tab 
 

 

____ 39. How many paragraph levels does PowerPoint 2007 allow? 

a. 4 c. 7 

b. 5 d. 11 
 

 

____ 40. If you want text indented on a line to create a lower-level paragraph, _____ the text. 

a. insert c. promote 

b. reduce d. demote 
 
 

____ 41. The ____ button is used to view the PowerPoint presentation in full screen view. 

a. Slide View c. Slide Sorter 

b. View Show d. Slide Show 
 

 



____ 42. You can run through slides in a slide show by clicking the mouse or using the ____ keys. 

a. F1 and F2 

b. PAGE UP and PAGE DOWN 

c. SPACEBAR and ENTER 

d. HOME and END 
 

 

____ 43. A(n) ____ proposal is a proposal that offers solutions to a problem or improvements to a situation. 

a. planning c. investigatory 

b. research d. sales 
 

 

____ 44. When the text color is Automatic, it usually is ____. 

a. gray c. white 

b. black d. blue 
 
 

____ 45. The Shading button arrow is on the ____ tab. 

a. Home c. Layout 

b. Paragraph d. Format 
 

 

____ 46. The Increase Indent button on the Home tab changes the indent by ____ inch. 

a. ¼ c. ¾ 

b. ½ d. 1 
 
 

____ 47. If you do not want the border style to carry forward each time the ENTER key is pressed, you need to ____. 

a. clear formatting c. press the ESC key 

b. return to the Standard style d. restore shading 
 

 

____ 48. All section formatting is stored in the ____. 

a. page break c. section break 

b. paragraph mark d. mouse pointer 
 

 

____ 49. The box that identifies the colors assigned to categories in a chart is called the ____. 

a. key c. legend 

b. index d. figure base 
 
 

____ 50. Use the ____ button on the Layout tab to create a single cell that spans across several rows in a table. 

a. Span Cell c. Blend Cells 

b. Merge Cells d. Single Cell 
 

 
Multiple Response 

Identify one or more choices that best complete the statement or answer the question.  

 

Modified Multiple Choice 

 

____ 51. The statement “names are global to the workbook” means that a name assigned to a ____ on one worksheet in 

a workbook can be used on other sheets in the same workbook. 

a. formula name c. cell range 

b. cell d. function name 
 
 

____ 52. The arguments in an PMT function are ____. 

a. rate c. beginning balance 

b. payment d. loan amount 
 

 

____ 53. Which are the financial functions? 

a. PV c. FV 

b. IF d. PMT 
 
 

____ 54. An amortization schedule shows the ____ of a loan, and the amount of payment that applies to the principal 

and interest for each year over the life of the loan. 

a. daily income c. ending  balance 



b. beginning balance d. daily cost 
 

 

____ 55. Print option check boxes available on the Sheet tab of the Page Setup dialog box are ___. 

a. Draft quality c. Row and column headings 

b. Formulas d. Functions 
 
 

____ 56. Commands on the Ribbon include _____. 

a. buttons c. galleries 

b. boxes d. top-level tabs 
 

 

____ 57. Which commands can be found under the Office Button? 

a. Open c. Cut 

b. New d. Save As 
 
 

____ 58. Which buttons are available in the Spelling dialog box? 

a. Ignore c. Suggest 

b. Change All d. Add 
 

 

____ 59. What ways are available to access PowerPoint Help? 

a. click F7 

b. click the Microsoft Office PowerPoint Help button 

c. click F1 

d. click the Help tab 
 

 

____ 60. Guidelines for the title page of a solicited proposal may stipulate the required contents such as ____. 

a. title c. sponsor name 

b. author name d. date 
 
 

____ 61. ____ is a SmartArt graphic type. 

a. List c. Index 

b. Process d. Cycle 
 

 

____ 62. ____ is a character effect available in the Font dialog box. 

a. Synthesized c. Superscript 

b. Engrave d. All caps 
 

 

____ 63. The body of a sales proposal may include ____. 

a. feasibility c. methods 

b. timetable d. equipment 
 
 

____ 64. If you hold down the ____ key while dragging the column marker on the ruler or a column boundary in the 

table, the width measurements of all columns appear on the ruler as you drag the column marker or boundary. 

a. SHIFT c. F4 

b. CTRL d. ALT 
 

 



 
Figure 1-1 

Modified Multiple Choice 

 

____ 65. In the accompanying figure, what buttons are on the Quick Access Toolbar? 

a. Save c. Undo 

b. Save As d. Redo 
 

 
Completion 

Complete each statement. 

 

 66. Excel lets you ____________________ before you enter data, when you enter data, incrementally after 

entering sections of data, and after you enter all the data. 

 

 67. In a formula, to use a name that is made up of two or more words, replace any space with the underscore 

character (_). For example, the name, Down Payment, is written as ____________________.  

 

 68. The _________________________ feature in PowerPoint provides the capability to share your presentation 

with others. 

 

 69. Press the _________________________ key to increase the indent, or demote, bulleted text. 

 

 70. The Cut button is located in the _________________________ group. 

 

 71. The _________________________ function key runs the slide show. 

 

 72. The ____________________ page should contain a short, descriptive title that accurately reflects the message 

of a proposal, for example.  

 

 73. A graphic or text that displays on top of or behind the text in a document is a(n) ____________________.  

 

 74. Graph places the contents of a table into a(n) ____________________. 



 

 
Figure 4-3 

 

 75. The ____________________ on the Layout tab is used to make uniform the row spacing in a table like the 

one in the accompanying figure.  

 
Matching 

 

Identify the letter of the choice that best matches the phrase or definition. 

a. Page order area f. PV (rate, periods, payment) 

b. Print titles area g. Cell errors as box 

c. unprotected h. Draft quality check box 

d. background formula checking i. FV (rate, periods, payment) 

e. PMT (rate, periods, loan amount) j. Gridlines check box 
 

 

____ 76. Prints row titles and column titles on each printed page of a worksheet  

 

____ 77. Speeds up printing by ignoring formatting and not printing most graphics.  

 

____ 78. Prints gridlines. 

 

____ 79. Returns the future value of an investment based on periodic, constant payments, and a constant interest rate.  

 

____ 80. Returns the present value of an investment. The present value is the total amount that a series of future 

payments is worth now. 

 

____ 81. Calculates the payment for a loan based on the loan amount, constant payments, and a constant interest rate.  

 

____ 82. Excel searches for errors in formulas while you continue to manipulate the worksheet.  

 

____ 83. Allows the value in cells to be changed at any time.  

 



Identify the letter of the choice that best matches the phrase or definition. 

a. CTRL f. CTRL+X 

b. F5   g. ALT 

c. ESC  h. ALT or ESC 

d. CTRL+O i. CTRL+F1 

e. TAB j. CRTL+S 
 

 

____ 84. End a slide show presentation.  

 

____ 85. Run a slide show. 

 

____ 86. Show a Key Tip badge. 

 

____ 87. Select nonadjacent text. 

 

____ 88. Save an existing presentation with same file name.  

 

____ 89. Promote paragraph. 

 

____ 90. Minimize the Ribbon. 

 

____ 91. Access the Office Button. 

 

____ 92. Delete text. 

 

Identify the letter of the choice that best matches the phrase or definition. 

a. shadow f. Microsoft Graph 

b. hidden g. datasheet 

c. watermark h. legend 

d. section i. Draw Table 

e. header j. footer 
 

 

____ 93. Feature used to create a complex table. 

 

____ 94. Where Microsoft Graph places the contents of a table. 

 

____ 95. A box that identifies the colors assigned to categories in a chart. 

 

____ 96. Text that prints at the top of each page in a document. 

 

____ 97. Used to change the top margin, bottom margin, page alignment, paper size, page orientation, page number 

position, or contents or position of header, footers, or footnotes in just a portion of the document.  

 

____ 98. Text that prints at the bottom of each page in a document. 

 

____ 99. Text or a graphic that is displayed on top of or behind the text in a document. 

 

____ 100. A light gray duplicate image that appears on the lower-right edge of a character or object.
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TRUE/FALSE 

 

 1. ANS: F PTS: 1 REF: EX 267 

 

 2. ANS: F PTS: 1 REF: EX 267 

 

 3. ANS: T PTS: 1 REF: EX 266 

 

 4. ANS: T PTS: 1 REF: EX 270 

 

 5. ANS: F PTS: 1 REF: EX 275 

 

 6. ANS: T PTS: 1 REF: EX 276 

 

 7. ANS: T PTS: 1 REF: EX 276 

 

 8. ANS: T PTS: 1 REF: EX 283 

 

 9. ANS: F PTS: 1 REF: PPT 2 

 

 10. ANS: F PTS: 1 REF: PPT 9 

 

 11. ANS: F PTS: 1 REF: PPT 11 

 

 12. ANS: T PTS: 1 REF: PPT 12 

 

 13. ANS: T PTS: 1 REF: PPT 12 

 

 14. ANS: F PTS: 1 REF: PPT 15 

 

 15. ANS: T PTS: 1 REF: PPT 18 

 

 16. ANS: T PTS: 1 REF: PPT 19 

 

 17. ANS: T PTS: 1 REF: PPT 24 

 

 18. ANS: F PTS: 1 REF: PPT 40 

 

 19. ANS: T PTS: 1 REF: PPT 43 

 

 20. ANS: F PTS: 1 REF: WD 248 

 

 21. ANS: T PTS: 1 REF: WD 250 

 

 22. ANS: F PTS: 1 REF: WD 255 

 

 23. ANS: T PTS: 1 REF: WD 266 

 

 24. ANS: F PTS: 1 REF: WD 283 

 

 25. ANS: T PTS: 1 REF: WD 271 

 
MULTIPLE CHOICE 

 

 26. ANS: A PTS: 1 REF: EX 270 

 

 27. ANS: A PTS: 1 REF: EX 280 

 

 28. ANS: C PTS: 1 REF: EX 284 

 

 29. ANS: C PTS: 1 REF: EX 290 

 

 30. ANS: D PTS: 1 REF: EX 295 

 

 31. ANS: C PTS: 1 REF: EX 310 

 

 32. ANS: C PTS: 1 REF: EX 320 

 

 33. ANS: D PTS: 1 REF: EX 320 

 

 34. ANS: D PTS: 1 REF: PPT 3 

 

 35. ANS: B PTS: 1 REF: PPT 7 

 

 36. ANS: D PTS: 1 REF: PPT 8 

 

 37. ANS: B PTS: 1 REF: PPT 8 

 



 38. ANS: B PTS: 1 REF: PPT 11 

 

 39. ANS: B PTS: 1 REF: PPT 19 

 

 40. ANS: D PTS: 1 REF: PPT 34 

 

 41. ANS: D PTS: 1 REF: PPT 48 

 

 42. ANS: B PTS: 1 REF: PPT 50 

 

 43. ANS: A PTS: 1 REF: WD 226 

 

 44. ANS: B PTS: 1 REF: WD 232 

 

 45. ANS: A PTS: 1 REF: WD 232 

 

 46. ANS: B PTS: 1 REF: WD 233 

 

 47. ANS: A PTS: 1 REF: WD 234 

 

 48. ANS: C PTS: 1 REF: WD 251 

 

 49. ANS: C PTS: 1 REF: WD 270 

 

 50. ANS: B PTS: 1 REF: WD 287 

 
MULTIPLE RESPONSE 

 

 51. ANS: B, C PTS: 1 REF: EX 279 

 

 52. ANS: A, B, D PTS: 1 REF: EX 280 

 

 53. ANS: A, C, D PTS: 1 REF: EX 281 

 

 54. ANS: B, C PTS: 1 REF: EX 297 

 

 55. ANS: A, C PTS: 1 REF: EX 307 

 

 56. ANS: A, B, C PTS: 1 REF: PPT 9 

 

 57. ANS: A, B, D PTS: 1 REF: PPT 14 

 

 58. ANS: A, B, C, D PTS: 1 REF: PPT 56 

 

 59. ANS: B, C PTS: 1 REF: PPT 63 

 

 60. ANS: A, B, C, D PTS: 1 REF: WD 229 

 

 61. ANS: A, B, D PTS: 1 REF: WD 234 

 

 62. ANS: B, C, D PTS: 1 REF: WD 243 

 

 63. ANS: A, B, C, D PTS: 1 REF: WD 249 

 

 64. ANS: D PTS: 1 REF: WD 286 

 

 65. ANS: A, C, D PTS: 1 REF: PPT 13 

 
COMPLETION 

 

 66. ANS: format 

 

PTS: 1 REF: EX 275 

 

 67. ANS:  

down_payment 

Down_Payment 

Down_payment 

 

PTS: 1 REF: EX 278 

 

 68. ANS: collaborating 

 

PTS: 1 REF: PPT 2 

 

 69. ANS: TAB 



 

PTS: 1 REF: PPT 39 

 

 70. ANS: Clipboard 

 

PTS: 1 REF: PPT 43 

 

 71. ANS: F5 

 

PTS: 1 REF: PPT 49 

 

 72. ANS: title 

 

PTS: 1 REF: WD 230 

 

 73. ANS: watermark 

 

PTS: 1 REF: WD 245 

 

 74. ANS:  

Datasheet window 

datasheet 

 

PTS: 1 REF: WD 270 

 

 75. ANS: Distribute Rows button 

 

PTS: 1 REF: WD 283 

 
MATCHING 

 

 76. ANS: B PTS: 1 REF: EX 309 

 

 77. ANS: H PTS: 1 REF: EX 309 

 

 78. ANS: J PTS: 1 REF: EX 309 

 

 79. ANS: I PTS: 1 REF: EX 281 

 

 80. ANS: F PTS: 1 REF: EX 281 

 

 81. ANS: E PTS: 1 REF: EX 281 

 

 82. ANS: D PTS: 1 REF: EX 319 

 

 83. ANS: C PTS: 1 REF: EX 313 

 

 84. ANS: C PTS: 1 REF: PPT 50 

 

 85. ANS: B PTS: 1 REF: PPT 49 

 

 86. ANS: G PTS: 1 REF: PPT 15 

 

 87. ANS: A PTS: 1 REF: PPT 22 

 

 88. ANS: J PTS: 1 REF: PPT 29 

 

 89. ANS: E PTS: 1 REF: PPT 35 

 

 90. ANS: I PTS: 1 REF: PPT 9 

 

 91. ANS: D PTS: 1 REF: PPT 55 

 

 92. ANS: F PTS: 1 REF: PPT 43 

 

 93. ANS: I PTS: 1 REF: WD 279 

 

 94. ANS: G PTS: 1 REF: WD 270 

 

 95. ANS: H PTS: 1 REF: WD 270 

 

 96. ANS: E PTS: 1 REF: WD 257 

 



 97. ANS: D PTS: 1 REF: WD 249 

 

 98. ANS: J PTS: 1 REF: WD 257 

 

 99. ANS: C PTS: 1 REF: WD 245 

 

 100. ANS: A PTS: 1 REF: WD 240 


